Experiences from Modeling and Exploiting Data in Air Traffic Control

James K. Kuchar
24 October 2012

This work was sponsored by the Federal Aviation Administration (FAA) under Air Force Contract FA8721-05-C-0002. Opinions, interpretations, conclusions, and recommendations are those of the author and are not necessarily endorsed by the United States Government.
CIDU 2012: Intelligent Data Understanding
Bringing Data and Models Together

Real System / Environment

Sensor / Transducer

Analysis

Data

Engineered System

Model

Information
Two Vignettes

1: Collision avoidance

- Data
- Model
- Algorithm

2: Airport departure management

- Data
- Model
- Human
Annual Flight Hours and Collision Rate

Worldwide Annual Jet Transport Flight Hours (Millions)

Year

Mid-Air Collision Rate (Per Million Flight Hours)

Mid-Air Collision Rate (10 yr moving avg)

Annual Flight Hours

Collision Prevention Layers

- Strategic Separation
  - Airspace Design

- Tactical Separation
  - Air Traffic Control

- Onboard Collision Avoidance
Traffic Alert and Collision Avoidance System (TCAS)

TCAS Aircraft

Traffic Display
Assists in visual acquisition

Resolution Advisory (RA)
Advises pilots how to maneuver

Transponder-Equipped Beacon Surveillance

1 Hz Range, Bearing, Altitude

TCAS-Equipped Beacon Surveillance and Maneuver Coordination
Überlingen, Germany, 1 July 2002
Überlingen, Germany, 1 July 2002

Russian followed ATC instruction to descend
DHL followed TCAS RA to descend

Led to changes in TCAS algorithms to improve reversal performance
Challenges for Decision Making

State Uncertainty

Imperfect sensor information leads to uncertainty in position and velocity of aircraft

Dynamic Uncertainty

Variability makes it difficult to predict future trajectories of aircraft

Multiple Objectives

System must carefully balance both safety and operational considerations

Alerting logic model needs to be matched to encounter characteristics
Collision Avoidance Chain

- **Strategic separation / airspace structure**
  - Airspace design
  - Airway / altitude structure
  - Flight plan / mission profile

- **Collision avoidance**
  - TCAS
  - Visual acquisition
  - Sense-and-avoid systems
  - Chance

- **Loss of separation / Close encounters**

- **Tactical conflict resolution**
  - Traffic callouts
  - Vectors

- **Collision**

- **Routine ATC actions**

**CIDU - 10**
J KK 10/24/2012
Traditional Development Process

Operational Data → Encounter Model → Dynamic Simulation → Observed Performance

Alerting Algorithm

Adjustments
Encounter Model Components

**Variables**

**Environment**
- Airspace class
- Altitude
- Aircraft equipage
- Aircraft type

**Aircraft State**
- Position, altitude
- Heading
- Airspeed
- Vertical rate
- Turn rate
- Acceleration

**Encounter situation**

**Requirements**
- Statistically representative geometries
- Physically realistic behavior
- Manageable size and execution time

**Challenges**
- Limited observed data to build model
- Selection of variables for model
- ID relationships between variables
Encounter Model Development History

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>TCAS Mandate (U.S.)</td>
<td>MITRE (US)</td>
<td>Vertical motion encounters Cooperative aircraft</td>
<td>12 radar sites 1,683 encounters</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Int'l Civil Aviation Org. (ICAO) (US &amp; Europe)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3D, single acceleration periods Cooperative aircraft 6 radar sites 2,387 encounters</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Eurocontrol (Europe)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>3D, multiple acceleration periods Cooperative &amp; non-cooperative aircraft</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>134 radar sites 411,867 encounters</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>FAA / Lincoln Laboratory (US)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>12 radar sites 1,683 encounters</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>TCAS Mandate (Worldwide)</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Markov Model Representation

A complete state transition matrix can have ~1 billion parameters, making this approach impractical.
Dynamic Bayesian Networks

Dynamic Bayesian networks compactly represent Markov models (Dean & Kanazawa, 1989; Murphy, 2002)

Conditional Probability Table

\[
P(\text{Turn}(t + 1) | \text{Turn}(t), \text{Vertical}(t + 1), \text{Airspace}(t), \text{Alt}(t))
\]

Only ~9,000 independent parameters required
Bayesian Network Structure Learning

\[ P(D | \mathcal{G}) = \prod_{t=1}^{T} \prod_{j=1}^{W_t} \frac{\Gamma(\kappa_{2j})}{\Gamma(\kappa_{2j} + N_{2j})} \cdot \prod_{k=1}^{\tau_s} \frac{\Gamma(\kappa_{3jk})}{\Gamma(\kappa_{3jk} + N_{3jk})} \]

Radar Data $\rightarrow$ Network Structure $\rightarrow$ Score

Unconnected

\[
\begin{align*}
\psi(t+1) \\
\hat{h}(t+1) \\
\hat{\psi}(t+1)
\end{align*}
\]

16 parameters

Optimal

\[
\begin{align*}
\hat{h}(t) \\
A \\
\hat{h}(t+1) \\
\hat{\psi}(t) \\
\hat{\psi}(t+1) \\
L \\
\psi(t)
\end{align*}
\]

9,296 parameters

Fully Connected

\[
\begin{align*}
A \\
L \\
v \\
\hat{h}(t+1) \\
\hat{\psi}(t) \\
\hat{\psi}(t+1)
\end{align*}
\]

7,651,840 parameters

Increasing number of parameters
Data gathered at Eastern / Western Air Defense Sectors, transmitted to 84th Radar Evaluation Squadron (RADES), thence to Lincoln Lab

Raw sensor data
- 134 sensors including CONUS and littoral / offshore coverage
- Not affected by filtering or tracking
- Primary and secondary radar returns
- 8 radar types (including long-range ARSR-4, short-range ASR-8 -9 -11)
- Includes height measurements for some sensors (e.g., ARSR-4)
- ~ 10 GB of data / day
Track Processing and Synthesis

Radar Track Database → Outlier removal
Track smoothing
Interpolation → Feature Extraction
Feature Smoothing
Quantization → Table Construction

P(\text{turn rate at } t+1 \mid \text{turn rate at } t, \text{altitude})

Synthetic Track Database → Track Generation
Feature Sampling → Feature Sampling

Results validated by comparison to other operational data
Traditional Development Process

Operational Data → Encounter Model → Dynamic Simulation → Observed Performance

Alerting Algorithm

Adjustments
TCAS V7.0 Sense Reversal Criteria

1. Has priority
   “Descend, Descend”

2. Current RA is not adequate

3. Reversed RA is adequate
Sense Reversal Behavior at Überlingen

Russian aircraft

- Had priority
- Climb RA provides adequate separation: No reversal

Algorithm relied on invalid assumption that own aircraft was following its RA
V7.1 Logic Change Proposal*

Test whether own aircraft is following its RA

Coordination ensures compatible reversals

“Climb, Climb” Priority Aircraft

Reverse: DESCEND

Coordination

Provides the aircraft that is following its RA an escape path

“Descend, Descend”

Reverse: CLIMB

* Other significant improvements are included as well
Simulation of Überlingen Geometry

Encounter with TCAS V7.0

Encounter with TCAS V7.1

TCAS V7.1 successfully reverses the RA sense
Performance Robustness Comparison

Near Mid-Air Collision (NMAC): separation < 100 ft
Example Monte Carlo Results:
Vertical Separation When One Aircraft Ignores RAs

- Change proposal affects 0.05% of runs
- 92% of changes involve separation gains
- 22% of changes are saves
- 2% of changes are induced NMACs
- 3% of changes are unresolved NMACs
Impact: European Adoption

TCAS version 7.1: Coming to a cockpit near you soon...

QuickRead
From March 2012 (new-build aircraft), Aircraft operating into European Union airspace will be required to have TCAS II V7.1 installed. Retrofit of older aircraft must be completed before 1 December 2015. While substantially similar to v7.0, Version 7.1 introduces a new “level off” RA designed to eliminate the potential for confusion or misunderstandings created by the existing “adjust vertical speed” RA. It is also

Version 7.1 solution – improved reversal logic
Version 7.1 will bring improvements to the reversal logic by detecting situations in which, despite the RA, the aircraft continue to converge vertically.
Problems with the Traditional Development Process

Operational Data → Encounter Model → Dynamic Simulation → Observed Performance

Alerting Algorithm

Traditional V7.1 upgrade process involved trial-and-error and spanned several years
A Direct Approach: Decision Theoretic Design

Alerting Algorithm

Decision Theoretic Design

Operational Data

Encounter Models

Dynamic Simulation

Observed Performance
Next-Generation TCAS
Logic Development: ACAS X

- Logic complexity is represented using numeric table instead of rules
- Table is standardized and given to system manufacturers
- Updates can be made to the system by uploading a new table
Markov Decision Process (MDP)

MDPs are a general framework for formulating sequential decision problems

- **State space**
  - Set of all possible states

- **Action space**
  - Set of all possible actions
MDPs are a general framework for formulating sequential decision problems

- **State space**
  - Set of all possible states

- **Action space**
  - Set of all possible actions

- **Dynamic model**
  - State transition probabilities
Markov Decision Process (MDP)

MDPs are a general framework for formulating sequential decision problems.

- **State space**
  - Set of all possible states

- **Action space**
  - Set of all possible actions

- **Dynamic model**
  - State transition probabilities

- **Reward model**
  - Reward for making transition

Objective is to maximize reward
Collision Avoidance MDP

State space

- Relative altitude
- Own vertical rate
- Intruder vertical rate
- Time to lateral NMAC
- State of advisory

Action space

- Clear of conflict
- Climb > 1500 ft/min
- Climb > 2500 ft/min
- Descend > 1500 ft/min
- Descend > 2500 ft/min

Dynamic model

- Head-on, constant closure
- Random vertical acceleration
- Pilot response delay (5 s)
- Pilot response strength (1/4 g)
- State of advisory

Reward model

- NMAC (-1)
- Alert (-0.01)
- Reversal (-0.01)
- Strengthen (-0.009)
- Clear of conflict (0.0001)

Dynamic Programming (DP)

DP is an efficient way to solve an MDP

Expected value

\[ Q(s, a) = R(s, a) + \sum_{s'} P(s' | s, a) V(s') \]

\[ V(s) = \max_a Q(s, a) \]

- DP is an iterative process for computing the expected value when starting from each state
- Best action can be derived directly from expected value
Dynamic Programming (DP)

Notional Expected Value Table

<table>
<thead>
<tr>
<th>State</th>
<th>Expected Value</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>No alert</td>
</tr>
<tr>
<td></td>
<td>Climb</td>
</tr>
<tr>
<td></td>
<td>Descend</td>
</tr>
<tr>
<td>Relative altitude</td>
<td>Time to go</td>
</tr>
<tr>
<td>Own vert. spd.</td>
<td>Intruder vert. spd.</td>
</tr>
<tr>
<td>100</td>
<td>19</td>
</tr>
<tr>
<td>200</td>
<td>20</td>
</tr>
<tr>
<td>...</td>
<td>...</td>
</tr>
</tbody>
</table>

- Rows correspond to different discrete states
- Table queried in real time on aircraft to select optimal action
Dynamic Programming (DP)
Dynamic Programming (DP)
Dynamic Programming (DP)
## Dynamic Programming (DP)

<p>| | | | | | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Controls:**
- CLIMB
- NO ALERT
- DESCEND

**State:**
- Green

**Action:**
- Red
Dynamic Programming (DP)
Dynamic Programming (DP)
Optimized Logic
Both Own and Intruder Level

![Graph showing optimized logic for both own and intruder aircraft, with areas for climb and descend based on relative altitude and time to NMAC.]

Climb
Descend

Relative altitude (ft)

Time to NMAC (s)
Optimized Logic

Own Climbing 1500 ft/min, Intruder Level

Relative altitude (ft)

Time to NMAC (s)

Climb

Descend
Pr(Safe) = 1-Pr(NMAC)

Safety Curve

Ideal system

Decreasing alert cost

ACAS X

TCAS
Performance Validation

<table>
<thead>
<tr>
<th>Airspace Encounter Models</th>
<th>Recorded Radar Tracks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generate many encounters representative of airspace</td>
<td>Recorded radar tracks with known TCAS intervention</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Stress Testing</th>
<th>Scenario Specific Mini-Models</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exhaustive variations of certain classes of encounters</td>
<td>Focused models constructed from expert knowledge and data</td>
</tr>
</tbody>
</table>

Future of ACAS X

• Performance validation continues, initial results positive
  – Reduced nuisance alert rate: 63% fewer alerts
  – Complex reversal / crossing alerts reduced by 52%-68%

• Operational flight tests starting in 2013

Final performance requirements and additional tuning will be vetted through a government / industry standards-making group
Two Vignettes

1: Collision avoidance

2: Airport departure management
Motivation for Improving Departure Management

- Estimated 75% of all US air traffic delays related to NY airports or airspace
- Severe Weather Avoidance Programs (SWAP) for convective weather in place 60-80 days per year in NY
Missed Departure Opportunities

30 minute cumulative arrivals and departures for JFK, LGA and EWR

- Many factors contribute toward missed opportunities
- Example of ‘difficult decision making’: time pressure, ambiguous information, significant consequences
Route Availability Planning Tool (RAPT)

- CIWS echo top forecast
- CIWS VIL forecast
- Weather Avoidance Field (WAF)
- Departure route database
- Deviation sensitivity field

RAPT provides 30 minute forecast of departure route impacts via dedicated and web-based displays deployed to FAA and airline facilities.
RAPT User Interface
RAPT Evaluations

- Deployment included annual training, user group meetings, and operational evaluations
  - Chicago (2010, 2012): extension of concept, site adaptation

- Evaluations combined simultaneous observations at all operational facilities with data analysis from several thunderstorm events
Example Post-impact Green Missed Opportunity

2 hour, 50 minute gap between end of weather impact and first departure
Missed Opportunities for Timely Route Reopening on Post-Impact Green

11 days studied (2008): 113 post-impact green opportunity events

Efficient reopening = departure within 15 minutes of Green
Missed opportunity = no departure within 15 minutes
Developments in Response

- Refocus training, ConOps on high confidence, high value decisions
- Provide additional information where uncertainty is high
- Provide automated next-day analysis and performance metrics
Additional Feedback to the User:
Daily performance summaries

NY RAPT/Route Usage Analysis - 08 September 2012

How to interpret these plots

Cumulative Departure Plots
Airport Departures

RAPT Route Departure Plots
RAPT "Post-Impact GREEN" Statistics

21200000 N2O/No-Calls 30 Minute Forward
Using RAPT to Proactively Reopen a Departure Route

July 29, 2010

Time to first departure = 0 minutes

Departure demand flush (10 in the first hour)

Persistent high departure rate during reduced impact (27 in 3 hours)

Departures on route (per 5 minute bin)

RAPT forecast timelines (5 minute updates)

Proactive re-opening of closed route releases pent-up demand efficiently
Impacts

- Improved performance and evidence of procedural evolution
  - More rapid, higher-volume route re-opening
  - Reduced reliance on pathfinders to validate open routes
  - Proactive ‘open on Yellow’ in anticipation of Green

- RAPT slated for FAA deployment to Chicago, Philadelphia, Washington DC, New York

<table>
<thead>
<tr>
<th></th>
<th>Delay savings (hours)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2007 TOTAL</td>
<td>2,366</td>
</tr>
<tr>
<td>2008 TOTAL</td>
<td>2,618</td>
</tr>
<tr>
<td>2009 TOTAL</td>
<td>5,549</td>
</tr>
</tbody>
</table>
• Models and algorithms need to be matched to actual operations via the available data

• Broad access to data, coupled with advanced techniques, are enabling new direct algorithmic design methods

• Many exciting challenges remain in Air Traffic Control
  – Extracting benefit from advances in Communications, Navigation, and Surveillance
  – Push toward more effective design and assessment methods